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Database

Field User Training
FY2013 Data Call
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Training Outline

Purpose of Report

User Roles

System Improvements
Logging On and Registration

Data Entry
— Solid Waste Management
— Printing and Finalizing Data

Welcome to the Sustainable Practices training.

You are welcome to leave the training after your relevant section has been discussed.

However, the Bureau and Office Central Office and HQ users should listen to the entire
presentation

The B/O Central Office user session will follow this one
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Before we get started, | want to review a few housekeeping items and let you know how
you can participate in today’s Web event.

We’re looking at an example of the GoToWebinar Attendee Interface which is made up of
two parts. The Viewer Window on the left, which allows you to see everything the Presenter
will share on their screen, and the Control Panel at the right. Within that Control Panel is
how you can participate in today’s event, so let’s look at that.

(Transition to Next Slide)



How to Participate Today
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Q&A addressed at the end of each
section of the presentation
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Start Holding your Own Web Events with
GoToWebinar
Webinar ID: 977-124-241

GoToWebinar™

Move mouse over the Grab Tab

Clicks 1,2, and 3
By clicking the orange arrow, you can open and close your control Panel

Click 4
From the View Menu you can also set the Control Panel not to auto-hide when inactive if you prefer to keep it always open.

Click 5

The Audio pane provides audio information. (If the organizer has given attendees a choice) By default you have joined the Webinar via
Mic & Speakers.

Click 6
Click Audio Setup to select your computer speaker or headset devices.

Clicks 4,5 and 6

If you prefer, you can join the audio via telephone by selecting Use Telephone, and the dial-in information will be displayed, including an
Audio PIN. If you would like to ask any questions of today’s presenters over the phone, you must enter your Audio PIN in order to have
your line unmuted.

Click 7

During (at the end, etc.) the presentation, you have the ability to send questions to our Webinar staff through the Questions pane. Simply
type in your question and click send. (Optional) At the end of the presentation we will do a Q&A session to answer as many questions as
we have time for.

Click 8

During the presentation we may ask you to answer a question by raising your hand. This option is located on the Grab Tab. (Optional)
You can also indicate that you have a question and would like your line unmuted by raising your hand.

Click 9 and 10

We will address Q&A at the end of today’s session, and as a final reminder, today’s Webinar is being recorded, and everyone will receive
an email within 24 hours with a link to view a recording of today’s event.



Training Norms

*All of the phone lines are muted.

* Please submit questions through the
“Questions” area.

*\We will respond to questions at the end of
each training section.

«You may leave the training after the sections
relevant to your work have been discussed.

-However, the Bureau and Office Central and HQ users should listen to the entire
presentation.

-The Bureau and Office Central Office users training session will follow this one.



PURPOSE OF REPORT




Management and Budget and the Council on
Environmental Quality

— Annual update for the DOI Strategic Sustainability Performance
Plan

— Annual DOI Greenhouse Gas Inventory

* Questions address:

— Executive Order 13514 - Federal Leadership in
Environmental, Energy, and Economic Performance

» Solid Waste and Chemicals Management
— Resource Conservation and Recovery Act
— Pollution Prevention Act of 1990




The Process

How is your data used?

Analysis'\"""'--..,.

by OMB
& CEQ

' N
DOI Strategic Y
Sustainability
S Performance
/ ~ Plan and
~ Greenhouse
Gas Inventory

The data input from Field Users are compiled in the Bureau-wide Report. The Bureau and
Office Reports are then used to develop the updated Department’s Strategic Sustainability
Performance Plan (SSPP) and the Greenhouse Gas Inventory. The SSPP is submitted to the
Office of Management and Budget (OMB) and the Council on Environmental Quality (CEQ).
If you are not familiar with them, but OMB and CEQ are part of the Executive Office of the
President.



Sustainable Practices Database
* The Sustainable Practices Database is
located at http://www.nbc.gov/spreport/

 Field User questions are a subset of the
OMB data call

* 18 questions

» Data entry should take 1 hour or less if
data is readily available

» System works best with Internet Explorer 7

10

System only includes those questions for which data depend on field
responses

10



USER ROLES

1

11



User Roles

Bureau
HQ
Program
Managers

Program
Managers

12

Here you can see the different layers of users.

12
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More on Roles

M Aantral Mffin AranA _lhna nramira
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contacts in your region, area, or state office.

At each level, there is a “solid waste
manager.”

Central and HQ roles perform data quality
review of field data.

Managers track report status for individual
facilities.

13

13



Data Quality Assurance

14
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Status Reports

SUSTAINABLE PRACTICES DATABASE

Status Report for Solid Waste Management

Facility Started Ernail

[o]:1 40012
(33 %)
HO 40012
(33 %)
District Office Emsail
OEPC Albuqguerque Regional Office Ernail
OEPC Anchorage Regional OMice Ernail
OEPC Aflanta Reglonal Office: Email
OEPC Boston Regional Office Email &
OEPC Demwer Regional Office Email Sample
OEPC Heatquarters = data only in
OEPC Oakland Email th is
OEPC Philadelphia Eml presentation
1
OEPC Portland Email
: not actual
Other Ernail
Program Office Email data
15

In the “Reports” tab, Central Office users may track the progress of individual facilities.
Select “Status Report for Solid Waste Prevention & Recycling” from the list of options. The
first column shows the name of the facility. The second column shows whether the facility
has started entering data. The third column shows whether a draft of the data is complete.
The fourth column shows whether that draft has been approved by the Central Office. The
fifth column shows whether HQ has approved the data. If a facility has started its data
entry but it is not complete, the Central Office may email the contacts for that facility to
inquire as to the progress of the facility’s data entry.

**Please Note that all of the data shown in this training are just for demonstration
purposes and are not actual data reported by facilities **

Questions?



LOGGING ON

Logging Into the System
Forgot Username or Password
System Registration

Change Password

Help Resources

16

16



Logging Into the System

Home ContactUs Help Login

Iyou are first time user, please click here to register

ifyou forgot your user name and/or password, please click here 1o have tis information mailed 1o you I

To unlock your account, please click here. Request a new password and A will unlock your sccount oo

Please enter your Usemarme and Password below and click the Login® buon

vsemamne: |
passwars, |
WGIDUSH%SOF THIS SYSTEM: This is & United States pubér Systim, b-;ml" of thit Intérior, o provide Oficial

only Use of this system by any authorized or consent i , retrieval, and
ulﬂlwuraw atmomu personnel. Unauthorized use may subject violalors to criminal, chil, and for ulsuplmary action,

17

To Login and register for the site, go to http://www.nbc.gov/spreport/ and then click on the
“Login” tab to see this screen.

Click “register here” if you are a new user.

Click “forgot your username/password” if you’ve forgotten your password or if you’ve been
locked out of the system.

If you've been locked out of the system due to unsuccessful attempts to login, click on “to
unlock your account”

Only request a password once, it takes up to 5 minutes for you to receive the new
password. Once you receive your new password, copy and paste it directly from the email
into the login page. Be sure to include any punctuation included in the password.

17



SUSTAINABLE PRACTICES DATABASE

ContactUs  Help

Login

Forgot Username / Password
Piease enter your compiete email address and indicate the type of assistance you are requesting, then click the “Submir buion. An email will be sent wilh the
requested information

Ermal Address:

€ Please conflern my Usermame.
€ Please reset my Password
€ Please confiern my Usemname and reset my Password

The password will bie sent 1o you within 5 minues. Ifyou request a new password, please bie sure that you enter it exaclly a5 # appears in the emad that you receie.
“You may want 1o iry copying and pasting the password from the email into the login page, including any punchuation that is included in the password. After you
successiully log in, you are encouraged 1o change your password 1o something you will remernber by going to the "Admin” tab and selecting “Update Password ™

TO USERS OF THIS SYSTEM: This is a United States

P system, the Dn of the Interior, o provide Official
Unclassified L8 Govemment information only. Use of this system by any constitul refrieval, and
by authonzed L use may subject violators to criminal, chwl, and for disciplinary action

Notices | Disclabmer | Privacy | FOIA | USA gov | DOI Home | PMB Home

U.S. Departman

18

This screen appears if you clicked on “Forgot Username/Password” from the Login screen.
Follow the instructions to request information and log in.



System Registration

e SUSTAINABLE PRACTICES DATABASE

4 o
Ay 3.\t

Home ContactUs Help Login

REGISTRATION

Please input your email address to begin registration.

Email Address: |

SUBMIT
VARRNING TO USERS OF THIS SYSTEM: This is a United States Govemment computer system, maintained by the Department of the Interior, to provide Official
Unclassified U.S. Government information only. Use of this system by any ar userc consentio , retrigval, and
disclosure by 1. Unauth use may subject violators to criminal, civil, and for disciplinary action

Motices | Disclaimer | Privacy | FOLA | USA gov | DOl Home | PMB Home

U.S. Dapardmant of the Interior

19

If you clicked on “click here to register” on Login screen, this page will come up. We have
added this step to prevent multiple registrations for the same person. When you enter
your email here the system will check whether you already have an account. If you already
have an account, you will be routed to a page where you can request that your username
or a password be sent to you. If you do not have an account, you will be routed to the
registration page, which is on the following slide.



SUSTAINABLE PRACTICES DATABASE

y  ContactUs Help Legin

Registration

It's important to
pick a password

= Aas i e =
= Contain 0ne Upper-case alpha, one lower-case alpha and one numenc charscler atioliows ese
= Contain ong special characier such a5 @. 5, o & 3 rules |

USER INFORMATION

Please complete the form Below snd click o Subeil bulion. you need help with Bis regiiation process, ok on
froeeed the fallowing criténa

owen: [SoeasBoemr 3]
e Once you pick
B = your bureau and
e, region, you will be
S 4 given a list of
First Name: li .y

facility names to
Last Name: - .
— T pick from here
Phoee Number. -
Password ————
Verify Password -

20

This is the screen that appears when you submit an email address that does not already
have an account. Enter your information into the form to register for the website. Then
click “Submit”



More on Registration

/our email address

e UUser name

e Tl E PRAT T T WS J

(

» Central office program manager will be
notified of new facility user registrations.

* You can register to enter data for more
than one facility.

* |If you move to a new facility, your central
office program manager can update your
user profile with your new contact and
facility info.

21

Generally, your user name is the same as your email address. You may specify a different
user name during the registration process if you like. Please keep a record of that user
name for future reference.



Change Password

Reports Bureau Report Generator dmin Help Logout

Site Administration

Action Hem Description

Update Password This tool allows user to change their password to access the system

Approve Solid Waste This tool allow admin user o approve Solid Waste data of a facility.

Managerment Data

Manage User Accounts This tool allows user o edit or 3dd users 1o the system. Regional / Stabe program leads should revidw users
registered in their jurisdiction o ensure appropriate personnel are accessing the system.

Change User Password This tool allow user 1o change password for existing users.

Manage Facilities List This tool allows user 1o edit or add facilities to the system.

Craate Email Listing This tool allows user 1o create an emall ksting of all the users in region of bureau.

Listing - Facilities and List of contacts associated with facilities

Contacts

Manage Regions List This tool allows user 1o edit or add regions to the system.

Add Motes Add notes to assist with preparing this report in the future. Future users from your region/bureau will have access
to these notes.

Notices | Disclaimer | Privacy | FOIA | USA gov | DOI Home | PMB Home

U5, Dapartmant of the Intesior
Office of Palioy Management and Budget
Last wpdated: Debsbar 23, 2012 22

This site has Bawn splimized for Intamat Explone: 7

If you are able to log into the system, you may change your own password by selecting the
“Admin” tab and then clicking on “Update Password”



Change Password

SUSTAINABLE PRACTICES DATABASE

Home Facility Data Reports Bureau ReportGenerator Admin Help Logout

Change Password

To update your password, please enler your new password and then confirm it A valid password must meet the following security standards:

» Be atleast 12 characters and no more than 15 characters

» Contain one upp: alpha, one | alpha, and one numeric character

« Contain one special character suchas @, 8, or &

» The new password canl contain the old p (e.g. the old canibe’ and the new p ‘p
Password:

‘Confirm Password:

SAVE

23

If you click on “Update Password” this screen will appear. Simply type your new password
into the fields provided. Then click on “Save” and your password will be changed.



Send us an

Check out
the FAQs

L4

Department of the Interior FY13 Sustainable Practices Database User Aids

Help Resources

ContactUs Help Login

« Signed DOl Data Call memo for FY 2013 Reporting on Solid Waste and Chemicals Management

.

FY 2012 Training Presentations - Updated FY 2013 Information Coming Soon

» Sustainable Practices Database Field User Training (EEE (3.5 MB)
» Sustainable Practices Database Central Office User Training (S5 (3.8 MB)

+ Sustainable Practices Database Bureau Headquarters User Training (S5l (1.1 MB)

Frequently Asked Questions

Feedback Form

Other useful links

» Guidance on wasle-to-energy and waste diversion

» EPA published standard volume to weight conversion factors
+ Conversion Factors used in this data call

24

If you need help, there are many resources available under the “Help” tab

resources are highlighted here.

Training presentations will be added to this page as well.

. Some of the

24



Feedback Form

» Use for all your questions and or
comments.
* Your feedback will automatically be sent to

the DOI contacts (OCIO and OEPC) as
well as designated bureau HQ contacts.

Feedback

Please Use This Form To Send Your Guestions or Comments

Name

Email Address
= 25
[ SuUBMIT

Questions?

25



DATA ENTRY

« Solid Waste Questions

* Print Report

«Finalize Data

« Central Office Data Review

26

26



PREVIEW OF
SOLID WASTE QUESTIONS

27

27



o— Navigation

location within the S R
system is shown & ' '

Home Facility Data Reports Bureau Report Generator Admin Help Logout

Home » Facility Diata » HH
Your facility

SOLID WASTE MANAGEMENT  Facility: OEPC Albuquerque Regional Office name |S

Solid Waste Prevention

Instructions to enter data shown here

QEVIGEN gy Recycing

Al this time we are only collecting wation for Solid Wast I you have questions, pleasa conact your Buresy
Contacts

ot o | » Lgers can save partially. complete or complets survey data by chcking on the SAVE button at the boltom of the page before
S AEVGEngG elsewhars
de:s::d Hazardous ‘ » Your data will be lost if you do ot click SAVE atthe bottom of each page
Co » Click onthe 2012 data under “Useful inks™ for the reports for Fy 2012
Forward Sclid Waste Data | * Click on the Bureau Contacts under "Useful knks™ 10 96 your reviewers
« VWhen ready, chck on any section 1o enter data

Print Solid Waste Data | + Youmust Forward Data before your raport is complets

USEFUL LINKS

Facility Notes |

Bureau Contacts |

2012 Solid Waste Data |

28

Here, the “Facility Data” tab has been selected.

They system has a left-hand side navigation bar, which lists solid waste management
sections of the report.

The user would complete each item under Solid Waste Management to complete the
report.



Find the name

information for
your designated Facility: OEPC Albuquerque Regional Office
Central Office and ! Instructions to enter data
bureau/office HQ '
contacts.

& ALthis time we & only Sold Wast mert . pledse contact your Buroay

® LIS&es Can Save Damaly- COMPlete of CoMplete SUrvey 088 by CACking on e SAVE buioe at the DOROM 0f the page before
nagatng sisenhons

o Your data wilbe kst you do not chek SAVE 8l the botiom of sach pags

* Chckion the 2012 data under Usehd knks™ for the repons for FY 2012

* Chckon the Bureu Contacts under "Usetul Bks™ 10 560 YOUr Tewewars

o WWhenready, chtk on any S6cion 1o erer data

= You must Foewand Data before your repor IS complets.

Review the Data

you submitted
for FY12. You
may print the
FY12 report and
refer to it when
compiling your
FY13 responses.

29

There is a link to bureau contacts for more information on how to complete this report.

You can click on the link on the lower left to see your facility’s 2012 data. The data have
been locked and cannot be changed.



Notes

USTAINABLE PRACTICES DATABASE

Facility Data Reports Bureau Report Generator Admin  Help Logout

Home » Faciity Data » Sold Waste Management »

SOLID WASTE MANMAGEMENT =~ Facility: OEPC Albugquerque Regional Office

e T Facility Notes
Reoyig aca es:

Waste Disposal ] Add notes 10 ssisiwith preparing Bis reporin B fulure. Fubune wsers Fom your acilly will have actess 1o These notes.

Chermicals Management

Exiterotes

here for next [T

vy [==]
and View Exi sing Note s for this Faciley

notes added Bureau Contacts o naestoind

in previous [ 2ot sobavestcoan |

years

Notices | Disclaimer | Privacy | FOM | USA gov] DO Home | PMB Home

Tt 5 Bk bt 43Tl 1o 1 St Expliser T

30
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Solid Waste Prevention

SUSTAINABLE PRACTICES DATABASE

¢Data Reports Bureau Report Generater Admin  Help Logout

Home » Faciity Data » Sokd Waste Management

SOLID WASTE MANAGEMENT =~ Facility: OEPC Albugquerque Regional Office

BETES A. Solid Waste Prevention
Recycing | Mot You messt chick on “SAVE™ below or your data will be lost,

‘Waste Disposal 1) Isyour facilty in leased space?

Toics and Hazardous | AL
|EChenia b ePORRerE 13) |5 your facility in leased space within a mulb-tenant buiding?
Forward Sold Waste Data T ves T Mo
Brint Sosd Waste Data 2)  Does your facilty have an active office products recycling program?
USEFUL LINKS “ ves T Mo
Facility Notes | 3)  Does your faciity have housing units?
[ ©

Bureau Contacts Yes Ne

— 33} I appikcable, how many residential housing units operated by your faciity have access o an active
2011 Solid Waste Data NOAUSEN0ID PROBUCTS FECYCING Program?

[ units of [ total units
The dstabase il sateutabs ha parearta B T A

4) Did your faciity institute new, substantially improved, or upgated nON-NAzardoy's Soid waste
in FY 20127 For additional information on solid waste prevention please go o
ittp:fiveew Epa goviR egion T/was efsoldwasteireduce_waste him
© Yes T Ne

It yes, explain {255 characters max);

3

Click on Solid Waste Prevention to begin data entry.

This screen will appear

The questions shown here are pretty straight-forward, just indicated whether your facility
(1) is in leased space, (2) has a recycling program, (3) has housing units.



Solid Waste Prevention (cont'd)

4] Did your faclty instiute new, substantially mproved, or updated T)  Within FY 2012 contracts na\mm faciity, oid ar nciude 3
i FY 20127 For sation on w0 RO Pl (FA8 Clawse 42 243 10) I GETOION, CONSTUCHON, 103 $envice Coriratts th achieve
it i 012 QR EQON TS e SR StETECUCE_waste fim Warste GvErsion goals? Provide SDECAC examples

- -
Yo Mo T ¥es T Mo T MetApplicable

s, axplain (258 characters mask |

5} Does your faciity compost any of &3 waste (ether onsite or offste)? ) VWNaLIs your faCRty's GOSN 10F SOMD Waste ahersion by 20157
SO ks Dirarsan g0 8 50% by 2018
Coves T Mo

Please input only numbers.

"y dalad 9) Do you have onste waste disposal, Such a3 a landfil, 3t your Facilty? Please answer “yes® if your
facity Nas a permtted Landrdl Tat was i1 0Perabon amytime between 1950 and to0ay.

T e T Mo

(R— =1
3] Hyes, how many demoliion progects managed by and/or conduched at your ety IClude the recewsy

e ———"

[ cemcatonproects e[ total demoktion projects in FY 2012 Mobces | Disclaimar | Privacy | FOW | LSAgov| D01 Home | PMB Heme

M w\m-n FY 2012 cwx“rorr:u R A 1m«mt»(weamwem of W
n 1) iR COnSUEiG, 310 S8TACE COMTIS 10 BETuEE
-*me m'mn noals"Dw !pecl\( examoln

T ves T Mo T MotApplicable

Save partially-complete or complete
survey data by clicking on the “SAVE"

button at the bottom of each page
before navigating elsewhere.

If you do not click on “SAVE" your
data will be lost!

32

Note that there are links to hints and helpful information for answering the questions, such
as links to “non-hazardous solid waste prevention practices” and “recovery of construction
materials”

Note that for question #5, the question on composting, re-use of materials onsite such as
mulch or grasscycling in landscaping is not composting. To count as composting, material
must be decomposed in some manner before it is re-applied to landscaping.

For question #9, we are asking whether you have an onsite landfill. If you do, you must
also answer question #9a and provide the amount of waste disposed of ONSITE during FY
2012.

When you are done entering data on this page, click “SAVE” — THIS IS CRITICAL, YOUR DATA
WILL NOT BE SAVED UNTIL YOU CLICK THE “SAVE” BUTTON

32



R I L]
SUSTAINABLE PRACTICES DATABASE
Jureau Repo ene Admin  Help
Home » Facility Data » Solid Waste Management »
SOLID WASTE MANAGEMENT Facility: OEPC Albuquerque Regional Office
I:w e Proventi BE. Recycling
) Recytling Mote: You mast click an “SAVE™ below or your data will be lost.
‘Waste Disposal 1) Indicate which of these commodites your faciity recycled during FY 2012 (10112 - 930/12). Waste
gy may not be counted as recycled.
P T Guidance on waste-to-energy and waste diversion
Chemicals ENEE I Aburniriam I Keyboard
Forward Solid Waste Data F antifreeze I Light Baliasts
USEFUL LINKS [ Batteries (Lead/acid - car) I Mied Paper
o P ok
RECREn [ Batteries (NiCd rechargeabie) I Mewspaper
I™ Batteries - Moed ™ Notebook PC
2011 Solid Waste Data
_ I Brick T pallets
I Car Tres I~ Plastic (#1PET/ZHDPE) Singl
I Cardboard I Priter ieS
Stream
I carpet I Serap Metals
. Category
Co-mmgled I Ceiling tiles I Single-Stream Mixed Recyclabies (steel and includ
category includes - aluminum cans, glass and plastic bollies, mbed Incluaes
1 Co-mingled (ghass Al cans, plastic) paper, cardboard) containers
most containers I Concrete I Stesl Cans and paper
33

Under “Recycling” click on the commodities that your facility recycled during FY 2013.
Then click “SAVE”.



Recycling (cont’'d)

B. Recycling

Mote: You must click on # SAVE® below or your data will be lost.

Please input the actual or estimated weight of volume of the total amount of each commodity recycled duing FY 2013 from your| CO nversion
facility. There are volume to weight Conversions programmed into the system for most commodities. f
actors used are

» EPA published standard volume to weight conversion factors, aValIable

through these
links.

» Conversion Factors used in this data call.

Salect Recycled C&D Waste only for items recycled as the result of construction and demoliion projects

+ C&D waste = construction and demolition waste.
» Ton=2,000 pounds
* Metric Ton = 1,000 kilograms = approximately 2,205 pounds

You must enter amount and select Type of Recycling for each commodity.

_ _ Select the Type
Commodty | AmountRecyded | Unit | Compecteanio | Typoof Reycing of Recycling

oter tos 7] [compected 3] here to avoid
Almi num [0 ™ B [ F i 7| L d receivirlg an
Cardboard o [1bs B [uncempacted = Other Recycling error later on
Mixed Paper [q | Ibs B | uncompacted = [W\el Ftwydinga

SAVE

For each commaodity that you selected on the previous page, you will be asked to enter the
amount recycled. You may enter the amounts in a variety of units, as shown here, but they
will be automatically converted to tons for the final report.

You must enter the amount recycled, there are some options for units you can use such as
tons, pounds, cubic yards, etc.

Under “type of recycling” you must enter whether the recycled waste is recycled
construction and demolition waste (C&D waste), composted, or other recycling. Other
recycling is generally recycled municipal solid waste.

Click “SAVE” when you’ve entered all of your data for the commodities recycled.



Recycling Data Tips

» Check your units — 100 tons of paper = 200,000
pounds of paper, which is a lot of paper.

» Check estimates of amounts recycled — A facility
once reported 200,000 cys paper recycled, this is
equivalent to 75,000,000 pounds. Please do not
over estimate.

* Be careful with decimals and zeros - extra zeros
can greatly increase your recycling amounts.

35
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Recycling (cont'd)

SUSTAINABLE PRACTICES DATABASE

Reports Bureau Report Generator Admin Help Legout

Home » Facility Data » Solid Wasie Management »

SOLID WASTE MANAGEMENT Facility: OEPC Albuquerque Regional Office

Sohd Vaste Prevention | cer .
| B. Commodities Recycling
I—Rmfw I For FY 2012, your facilty recycled
100 Ibs of Uncompacted Antifreeze - Other Recycling = 100,000 Ibs
| ‘Waste Disposal | 50 Ibs of Uncompacted Manure - Composted = 50,000 Ibs
Totak 150 Ibs = 0.075 tons
Tawics and Hazardous Total Composted Recycling: 50 Ibs = 0.025 tons
Chemicals Tatal C&D 0 Ivs = 0.000 tons
Total Other 100 s = 0.050 ons
| Foward Solls waste Data |

The Recycling data has been saved for this facility
Please proceed fo Sclid Waste Management Waste Disposal (

[ Print Solid Waste Data

USEFUL LINKS

L Faciliity Notes |

| Bureau Contacts |

2011 Solid Waste Data |

36

After you’ve entered information for your commodities recycled, you will see a summary of
the data you entered for those commodities.

After reviewing the data, click on the link to proceed to the “Waste Disposal” section of the
report.



Waste Disposal

rts  Bureau Report Generator Admin  Help Logout

All Other Trash (Municipal 00000 Ibs >
nagement » Solid Waste) sent to Waste-
to-Enesqy

Facility: OEPC Albuquerque Regional Office o Total amount of waste sentlo

C. Waste Disposal & ash that

cled and was sent

Mot @ You must clck on “SAVE” below of your data will be lost.

gt orily I youu o ot hanve amy of thes @ Types of waste.
of Do notinclude any materials
Type of Waste Ameaint | Unit eIt
o Do notinclude irash sentto a
Construction and Demolition [osoo0 [[ies = warste incinerator that is not a
Waste Sent to Landfil or warste-bo energy facility.
Waste-o Ener gy (CAD Wasie)

f 0f LAY LB
Nead help estimating waste amount?

Guidance on waste-to-energy data

Frovice comments here about Your waste repored, if amy.

‘Solid Waste) sent 1o Landfil
= Total amourd of waste 5 ent o
lanaill during FY 12
o Do notinchude C & D waste
reported above.

# Do natinchdeany material You must enter data on this screen or
e vy you will receive an error message.

Al Othes Trash (Municipal 100.0000 Ibs 'I(

A8 Other Trash (Municipal 10.0000 Ibs x 37

Soiid Wasiv) seni io Wasie.

In the Waste Disposal section you will be asked about the total amount of waste disposed
and not recycled.

Do not include any amounts recycled on this page.

Report amounts for:

- Construction and demolition waste not recycled

- Municipal solid waste sent to the landfill and not recycled
- Waste sent to waste-to-energy facilities

Click on “Need help estimating waste amount?” if you need assistance.

Also please note that any waste burned for energy is not considered to be diverted waste.
You may still report the amount burned for energy here. Please see the linked Guidance on
Waste-to-Energy Data.
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Waste Disposal (cont’d)

ta Reports Bureau Report Generator Admin  Help Legout
Home » Facility [ata » Sokd Waste Management »

SOLID WASTE MAMAGEMENT  Facility: OEPC Albuquerque Regional Office

= iz C. Waste Disposal
me The Waste Disposal data has been added for this facility
‘Waste Disposal | | category Undiverted Waste fons) Recycled Qons) Dwversion rate

Toodes and Hazarcous e 0005 0.000 0.00%
Chemicals Management

0055 0075 57 69%

Total 008 0075 55.56%

| Forward Solid Waste Data |

PLSOKIWSHEDHD |  Recyiamutonsts
USEFUL LINKS Recycied materils + Trash
Facility Notes ]
Bureau Contacts Ssisslout:

Your undiverted municip al $old waste has resuted in approdmately 040161 MT COZe (metic fonne carbon digude

2011 Solid Waste Data aguivalent) in greenhouse gas emissions.

© “Greenhouse Gas Emissions amount = short lons of undiverted municipal waste x 0,730 2 NTCOZefshor ton

Denartment YWaste Diversion Goak: 50% or more by FY 2015
Your facility has met o1 sxcosded the Dopar tment’s goal
Guidance on how b enhance your Waste Diversion and Recycking Program

Stats Wasto Diversion Goak 50.00 %."
Yom huave et of exceeded your Siate’s waste dversion goal.

* Wote: Rucant shangas b Slate miste divartion goals sy a4l ba & e hase

ang Hazardous Chemicals Management a8

PFlease procend 10 Sobd Waste Man agement Texc

Once you have entered and saved all of your data for Recycling, you will see this screen.
Note that there are additional links providing information on how to enhance your waste
diversion and recycling program and about recycling goals. Click on the link at the bottom
to “Proceed to Solid Waste Management: Toxics and Hazardous Chemicals Management.”



Data Entry Guidelines

Facilities must provide data for undiverted waste in addition to what was
recycled for both municipal solid waste and construction and demolition
(C&D waste).

Undiverted waste is the amount that went to the landfill and/or waste-to-
energy (WTE) facilities.

Facilities reporting only amounts recycled and a 100% recycling rate
will be asked to explain why they have such a high recycling rate.

Report amounts of biomass/wood chips burned onsite for heat or
electricity as WTE if wood would have otherwise gone to a landfill

Even if waste disposal is free, the amount disposed of should be
reported.

Please do not double count. If a quantity of a commodity is reported as
recycled, that quantity should not be included in the landfill or waste-to-
energy amounts.
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Toxics And Hazardous

Chemicals Management

Home FacllityData Reports Bureau ReportGenerator Admin Help Logout

Home » Facsty Data » Sobd Waste Management »

SOLID WASTE MANAGEMENT ~ Facility: OEPC Albuquerque Regional Office

I Preventon . .
_SOIUWaste S Toxics And Hazardous Chemicals Management
Sy iy | Mot You rmst click om “SAVE® below or your data will be lost,
‘Waste Disposal 1) Briefly describe what your faciity has done to reduce the purchase of todc and hazardous chemicals
e D0 Not report quantiative Iformation (volume of dollars) on chemicals of chemical-containing products.
Toodts and Hazardous purchased or reduced
Chemicals Management
S T—— have a plan 1o repla ¥ Wilh hon-mercury allematives
Forward Solid Waste Data
Print Solid Waste Data
USEFUL LINKS
Facility Notes
Bureau Contacts

2011 Solid Waste Data

40

This is the page to enter information on your facility’s efforts to reduce the purchase, use
and disposal of toxic and hazardous chemicals. Enter your narrative information and click
“SAVE.”



PRINT REPORT
FORWARD DATA

41
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Printing your reports

* Print a copy of each report before you
finalize!
— Hard copy can be circulated for review and
approval within your facility prior to finalizing
— Click on “Print Solid Waste Data”

— Navigate to web browser and select print
function there

42
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When you are

done entering

data, you may
print your

report here.

Printing your reports

Home » Faciity Dats » Solkd Waste Management »

Facility: OEPC Albuquerque Regional Office
SOLID WASTE MANAGEMENT

Summary: Solid Waste Management -

ek on the PRINT bufton to prind th report

A. Solid Waste Prevention
1) Isyour facilty in lexsed space?
1a) s your facilty in leased space within a multi-tenant buliding?
2)  Does your facilly have an active office products recycing program?
3) Does your faciity have housing units?
3a) ¥ appiicable, how mamy residential housing units operated by your facility have access to an active

househokd products recycing program?

units of total units
The atsbaee wall caboulate B e parcentge based o the nomd ar of units you provide hare

4)  Did your faciity institute new, substantially improved, or updated non-hazardous Solid waste prevenbion
[practices in FY 20127

It Yes, please explain (255 characters max):

5) Does your faciity compost any of its waste (either onsite or offsite)?

43

It yes, select the type of compoesting.
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Forward Data

SUSTAINABLE PRACTICES DATABASE

Facility Data Reports Bureau Report Generator Admin Help Logout

Home » Facility Data » Solid Waste Management »

SOLID WASTE MANAGEMENT Facility: OEPC Albugquerque Regional Office

| Sold Rre | Toxics And Hazardous Chemicals Management

| Recytling | The Toxics And Hazardous Chemicals Management data has been saved for this facility,

Click here for Waste Disposal

your report to Toxics and Hazardous

be forwarded Chemicals Management
to the Forward Solid Waste Data

] Please proceed 1o Solid Waste Management F orward Solid Waste Data

FEQiﬂnaL Print Solid Waste Data
state or area USEFUL LINKS
office |

Bureau Contacts ]

| 2011 Solid Waste Data l

Facilty Notes |

When you have completed entering the data for Solid Waste Management or Green
Purchasing, you must “Forward Solid Waste Data” before it is sent to the Central Office for

approval.



System Checks

Facility: District Office

Forward Solid Waste Management Data

Vour daia is compieie bui

The total recycled amount for your facility is at least 10 bmes greater than the FY 2011 recycled amount
The total trash amount for your facilily is at least 10 imes greater than the FY 2011 irash amount

The total recycled amount for your facility is 3t least 1000 tons more than FY 2011 recycled amount

Pleass verily the data you've enlised andiod prowide an explanalion hare

Please select reason's:

™ Facilty Expanced Recycling/Composting

I~ Facity Started Hew Recycling/Composting

( Facilty had a singular event that increased/decreased quanibes
™ Disposal increaseidecrease was due to changes in Visitaon
™ Usage or Temporary Facilty Clasure

F Improved Tracking

™ Weighing Trash instead of Volume Estimates

™ Asded New Materials 1o Recycling Program

Please explain:

ore accurate tracking

* The system checks for data completeness and
consistency when you click on “Forward Solid
Waste Data”

+ Errors iike the one shown here appear when:

» Recycling is 10 times or greater than last
year's amount

*Recycling is less than 10% of last year's
amount

*Greater than 50 ton variation in trash or
recycled amount if total waste is 100 tons or
less.

* Non-diverted waste is 10 times or greater
than last year’s amount

* Non-diverted waste is 10% or less of last
year's amount

+Greater than 1,000 ton variation in trash or
recycled amount

+ Recycling rate is 100%
* You must either correct your data or provide an

explanation when you receive this error.
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System Checks

s Bureau Report Generator Admin  Help Logout . These erro rS Shew
agernent »
that we have not
Facility: OEPC Albuquerque Regional Office ente red al | Of the
Forward 5olid Waste Management Data req u Ired data'
‘Your data on Solid Waste Management Data is not complete yet. Please enter all the data and then finalize
it. Please compiete the following data . We must
The d h /Solid is lete.
on new, improved, or updated solid waste prevention practices (Solid com plete th ese

Waste Prevention #4).
Expi on Req

for Waste Red: Plans.(Solid Waste Prevention #7) e ntries p riO r tO
forwarding our
data.
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If your data are not complete when they are finalized, a screen will appear to tell you what
information is missing and must be completed before it can be finalized. You must enter
this data before it can be submitted to your Central Office.
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Forward Data

s Bureau Report Generator Admin Help Logout

nagement »

Facility: OEPC Albuquerque Regional Office

Forward Solid Waste Management Data
= Afteryou click on "Continue™ your regional or central office will be notified that your facility data are available for review.
* Afteryour data have been reviewed al the regional or central office level, your data will be forwarded 1o your bureau

headquarters for review and inclusion in your bureau’s Sustainable Practices Report

If all the data for Solid Waste has been added / edited completely, check the box to forward the facility data
for regional approval

) ™ Forward the Solid Waste facility data for approval.

CONTINUE

47

If you have completed all of the information required by the Sustainable Practices
Database, you will see this screen when you click on “Finalize Data”. Click on the box to
forward your data, and then click on “Continue” for your data to be forwarded to the
Central Office for approval. Your Central Office manager will receive an email notifying
them that your report has been finalized.

Once you have finalized your data, the facility user will not be able to edit it. If you discover
an error, contact your Central Office to return the data to you so that you can make the
change. If data is returned and sent back to you, you must finalize the report after you
make your changes so that the Central Office will be notified you have made your changes.

You will receive an email if your Central Office returns your report to you for changes.
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Central Office Data Review

an_=_

A s
Tnis

tage:

- If edits or clarification are I—— Facility User enters data
necessary the Central -

Office program reviewer — _ _ ﬁ
sends report back to [ Facility User finalizes data and forwards it for review

Facility User.

- Then the Facility User
makes changes and re-
finalizes the data, sending
the report back to the
Central Office.

-If no changes are needed,
the Central Office User can
forward data to the Bureau
HQ User

48

Once the Central office receives the data, the Central Office may decide that there is a
problem with the facility data that must be corrected before it can be forwarded on to the
bureau or office HQ level for approval. If there is a problem with facility data, the Central
Office User may send the data back to the facility user for correction by “Unapproving” or
“Returning” it.

If the Central Office sees that the data for its facilities are ready to be forwarded on to the
Bureau HQ level, the Central User may then forward the data on. For more information on
this process, please see the Powerpoint presentation for Central Office Users.
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Historical Reports

Home Facility Data Reports Bureau Report Generator Admin Help Logout

Soiid Waste Reports - Historicai Bureau Data
Report ondy includes data for active facilities. Previous years' data for faciliies that are curmently deactivated are not included

Al AMOounts are in tons.
Click on the bureau name lo see the data for the regions.

Download historical data in EXCE

02 011 w0

Recycled (lons) Waste flons) Waste Diversion  Recycled (lons) Waste flons)  Waste Diversion  Recycled (lons)  Waste flons)  Waste Diversion
Total 226,069.07 04,172.02 70.59% 4161 115.19 16.54% 487527 8,380.88 36.78%
os 1.57 0.00 100.00% 0.49 o018 0.54% 1521.42 48.38 96.92%
NPS 50,364.81 63.27T% .12 2501 62.10% 33154 1,630.00 67.11%
FWS 2451748 47.30% 0.00 0.00 0.00% 0.22 0.00 100.00%
USGE 937,54 B567% 0.00 0.00 0.00% 0.00 0.00 0.00%
BOEWBSEE 4387 67.41 394T% 0.00 0.00 0.00% 0.00 0.0o 0.00%
OSMRE 40,06 38.76 50.81% oo oo 0.00% 0.0 o.0o 0.00%
Bia 014 0.00 100.00% 0.00 0.00 0.00% 0.00 0.00 0.00%
BLM 25,999.04 4,261.36 8597% oo 0,00 0.00% 0.00 0.00 0.00%
BOR 7353112 471388 93.98% 0.00 0.00 0.00% »1 6,702.50 0.471%
NBC 31037 270,79 5341% 0.00 0.00 0.00% 0.00 0.00 0.00%
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Within the “Reports” tab, there are reports with historical data available. This report
compares solid waste data for the last three years.

To drill down within the bureau, just click on the Bureau name, and on the following screen
click on the Region name. You will then be able to see the facility historical data.

If you “Download historical data in Excel” you will see data for all years that data are
available.



Historical Reports

2010 Reports

Click on the Solid Waste report to print & cogy of solid waste report for that facility
Facility (Region) Solkd VWaste
Office of the Secretary
HO
District Office:

OEPC Albuquergue Regional Office
OEPC Anchorage Regional OMce
OEPC Atlanta Regional Office
OEPC Boston Regional Office
DOEPC Denver Regional Office
DEPC Headguarters

OEPC Oakdand

QEPC Priladeiphia

OEPC Portland

Other

Program Office Solid Waste Report
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You can also download complete reports for each facility for FYs 2006 - 2012.
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Questions can be emailed to SPReport@ios.doi.gov

QUESTIONS? WRAP-UP

51



